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1.  Introduction 

1.1. What is Adlib? 

Adlib is not only the name of our company but we also use it to de-
note our computer programs, with which you are able to manage 
large quantities of information in a structured manner. 
There is a difference between the Adlib software (programs) and the 
applications. The software contains all code that deals with reading 
and writing in databases, and all accompanying functionality, and is 

executed in files with the extension .exe and/or .dll (and some periph-
eral functionality in bin files). This software has been designed espe-
cially for the management of data from libraries, museums, archives 
and similar institutions. 
The Adlib applications consist of databases and user interfaces (tab 
sheets with fields, for instance) – really only a collection of data – of 
which the software creates a usable program.  
This structure makes it possible for you to install new software regu-
larly, which contains new functionality, while nothing changes in your 
application (which you may have customized yourself). That is why 
your software can be upgraded regularly to a new version number 
(e.g. 6.5.0) when you install a new release, whilst your application 
version always remains the same (e.g. Adlib Library 3.4). 

Adlib is structured much like a card tray, with related data (e.g. from 
a magazine) being stored together. In Adlib however, the equivalents 
of cards are called records. A collection of records is referred to as a 
database rather than a card tray, and a subset (partial collection) of a 
database a dataset. In an application you can fill or edit such a data-
base or dataset.  
Data is entered and per subject presented on forms on tab sheets 
(screens), but is part of one and the same record. 
So called indexes are used so that data can be retrieved as quickly as 
possible; indexes are alphabetical or numerical lists of terms with a 
link to the record in which such a term occurs. You can search and 
sort, display, print and/or store the results in different ways. 

 
Adlib has an exceptionally flexible structure. With the so called 
Adlib tools, the system can easily be adapted to meet custom-
ers’ wishes and requirements. For example, customers can 
themselves choose what data is to be stored, and how the da-
ta is to be displayed. You can also choose for which data in-
dexes are to be made, and in what way these indexes are to 
be made accessible.  
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When you buy Adlib software, you’ll also get one or more applications, 

dependent on your licence. An application is sometimes subdivided 
into various modules, each of which represents a separate aspect of 
the activities in your library. For instance, for Adlib Library there is a 
module for serials management, and a module that visitors to the li-
brary can use to search the catalogue, but also the module that is de-
scribed in this manual, to process loans. These and similar modules 
are extra, and have to be purchased separately from a catalogue 
module.  

1.2. What is Adlib Loans? 

The Adlib Loans module comprises two module interfaces called: Ad-

loan Circulation and Adlib Loans Management: 

• Adloan Circulation (aka Loan transactions) is a software applica-
tion with which you process the lending of items from a biblio-
graphical collection. 
The items themselves are registered in the databases of an Adlib 
Library application (Catalogue Management). Adloan Circulation is 
linked to this application. 

• You also have a Loans Management module interface, which is 
linked to Adloan Circulation too. In here you may register borrow-
ers, print reminders and notification letters, establish borrower 
groups – with details of what they are allowed to borrow – and es-

tablish loan categories for materials that can be borrowed. This 
module interface is described in chapter 10: Loans Management. 

Adlib Designer 6.4 or higher must be used to make Adloan Circulation 
operational by setting up some default values like library branches, 
users, fines, opening hours, etc. Before Adlib 6.5.0, settings for mak-
ing Adloan Circulation operational could be changed in the ACSETUP 
tool (Adlib Circulation SETUP), which was only being used for this 
particular module interface. With Adlib 6.5.0, all ACSETUP functionali-
ty has been moved to Adlib Designer. In the Designer Help (see the 
figure below) you’ll find all information about setting up Adloan Circu-
lation. Preferably you make these settings after you’ve installed Adlib 

Loans and before you start using it, but you can make changes at any 
later time too.  
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Technical information 

Loans Management and Catalogue Management are normal Adlib 
software application interfaces which run on the adlwin.exe program, 
but Adloan Circulation is different because it must be workflow ori-
ented to be able to register loan transactions easily. That’s why this 
application runs on the adloan.exe program. On the other hand, 
Loans Management and Adloan Circulation are started in the same 
Adlib Software subdirectory \WADCIRC (Adlib CIRCulation for Win-
dows) or in \library loans management because they are both inter-
faces to the Loans module. (Catalogue Management belongs to the 
Library application and is started in \WINCAT or \library) See the In-
stallation guide for Adlib Museum, Library and Archive, for infor-
mation about creating desktop shortcuts to said module interfac-

es/applications. 

1.3. About this manual 

In this manual we assume that you are familiar with the Adlib soft-
ware. If you are not, we advise you to read the general Adlib User 
Guide for information about the functionality of the Adlib software, 
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such as searching, using menus, entering data, and editing and print-

ing. 
The module guide before you describes some specific aspects of the 
Adlib Loans module interfaces and setup tool, that need further expla-
nation. See the “Data entry instructions for Library”, or consult the 
contextual help in the application itself (F1), for a description of the 

fields. 
Since there are still variations within application versions, and be-
cause different version numbers do not necessarily mean big applica-
tion differences, this manual has not been written for one particular 
version number; that is why it is possible that fields and/or tabs dis-
cussed in this guide, are not present in your application, or that fields 
appear on a different tab. Only the chapter and other texts about re-

minders is specific to application version 4.2. 
 
To distinguish between descriptive text and text that you see on 
screen, different typefaces have been used.  
• Text that is displayed on screen and used in menu titles and on 

buttons is in italic type, e.g.: 
Full catalogue 
Combine 
Search 
 

• Text that you type in yourself is printed in monospace type, like 
that produced with a typewriter, e.g.: 
You typed this yourself... 

 

• Keys on your keyboard are indicated with a narrow, bold font, cor-
responding with what is printed on the keyboard, e.g.: 
Enter 

Page Down 

F1 (Help) 

Sometimes, you have to press two keys. This is indicated by a 
plus character between the two key names. In this case, you 
should press the first key and then the second key, keeping the 
first key pressed down, e.g.:  
Ctrl+C 

 

Remarks and warnings are printed in a frame like this, or just as an 
indented paragraph. 

The way screen shots in this manual are displayed might differ from 
the display on your own monitor, depending on your Windows version 
and monitor screen resolution. 
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2. Starting Adloan Circulation 

2.1. Using shortcuts 

Start Adloan Circulation by (double)-clicking the appropriate icon (a 
shortcut to Adloan Circulation/Adlib loan transactions) on your Desk-
top or in the Windows Start menu. 
 

 
 
Settings in that shortcut determine how Adloan Circulation is started. 
See Appendix  for information about these settings. 

2.2. Logging in through session parameters 

 
 
After your library dependent settings have been made for Adloan Cir-
culation via the Loans Management module (see chapter 10) and Adlib 
Designer (see the Designer Help), you may start registering transac-
tions in Adloan Circulation. 
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When you start Adloan Circulation, the Session parameters login win-

dow is opened in the main screen. To prevent from everybody being 
able to register loan transactions, in here you’ll have to log on to the 
Adlib server by entering the name of that server, your location 
(branch), your user name and your password, and then clicking Con-
nect. 
• When you work with the client/server version of Adlib Loans – so 

you’re not running Adloan Circulation as a stand-alone application 
–you must log on to a certain Server. (Your system administrator 
will know its name.) If you start up the module as a stand-alone 
application, you may ignore the Server entry field.  

• In the demo version of Adlib Loans you may use the Location 
main, the User name user1 and the Password pw1.  

• When you type in the password, it won’t show on screen: each 
character will be represented by an asterisk, so no-one can read 
your password. 

Next, click Connect, to start your session. You may now start pro-
cessing Issues, Returns or Reservations: select the appropriate tab. 
There are also a number of other possibilities, such as the processing 
of payments. The possibilities will be discussed in detail, further on in 
this manual.  

2.3. Opening and closing sessions 

In your Adloan Circulation you can close your current session, without 
closing the program, via the Session > Close current menu option. 
You should close your session if you are going on a lunch break and 
leave this computer unattended, or when a colleague takes over your 
place at the loan desk for the coming hour(s). 
You can open a session via the Session > New session menu option. 

In a stand-alone situation only one session at a time can be opened 
on your computer, while in a client/server situation you may open 
multiple sessions, even in one and the same application window. 
You can switch quickly between several opened sessions, via the op-
tions in the Window menu. Feel free to experiment with them. Details 

about the currently opened session in the active window are displayed 
in the status bar at the bottom of the screen. 
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3. The interface of Adloan Circulation 

The figure below displays the user interface of Adloan Circulation. 

 

 Tabs 

Issues, returns and reservations each have their own tab sheet. Open 
the desired tab by clicking its label. 

 The menu bar 

If your application can run in different languages, you can switch be-
tween these languages via the Language menu. You can switch lan-
guage at any moment. 



With View > Device properties you can set up serial barcode scanners, 
should that be necessary. (See Appendix 2: editing the print slips 
 Adlib Loans 

8 

4. With View > Device properties you 
can set up serial barcode scanners, 

should that be necessary. (See Appen-
dix 2: editing the print slips 

 

From within Adloan Circulation you can print issue slips, return slips 
and reservation slips for the borrower, to remind him or her about any 
borrowed, returned or reserved copies. 

The contents of these slips (fixed texts and Adlib field references) are 
determined by special templates in the Adlib \executables folder, 
which you can edit.  
In old (pre-7.2) Adloan versions, these templates were made up by 
six types of .rtf files (you can edit these in WordPad): islipall#.rtf, 
islipone#.rtf, dslipall#.rtf, dslipone#.rtf, rslipall#.rtf and rslipone#.rtf, 
in which # stands for an Adlib language number (English = 0, Dutch = 
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1, French = 2, German = 3, Arabic = 4, Italian = 5, Greek = 6, Portu-
guese = 7, Russian = 8, Swedish = 9, Hebrew = 10, Danish = 11, 
Norwegian = 12, Finnish = 13 and Chinese = 14).  
However, from Adloan version 7.2.15061.3 or 7.3.15065 six XSLT 
templates (which have more possibilities than the .rtfs), plus a single 
XML file containing fixed texts in different translations are used by 
Adloan by default.  
If you start using a new Adloan version but you have no desire to use 
the XSLT stylesheets, then simply remove them from the \executables 
folder and store them in a backup folder somewhere else: Adloan will 
then revert to using the old .rtf templates. 
If you’d like Adloan to use the XSLT stylesheets, make sure the follow-

ing files reside in the Adlib \executables subfolder: 

• issue-list-all.xsl (replaces islipall#.rtf) to generate the Overall 
issue slip. 

• issue-list-one.xsl (replaces islipone#.rtf) to generate the issue 
slip for one or more selected copies. 

• return-list-all.xsl (replaces dslipall#.rtf) to generate the Overall 
return slip. 

• return-list-one.xsl (replaces dslipone#.rtf) to generate the re-
turn slip for one or more selected copies. 

• reservation-list-all.xsl (replaces rslipall#.rtf) to generate the 

Overall reservation slip. 

• reservation-list-one.xsl (replaces rslipone#.rtf) to generate the 
reservation slip for one or more selected copies. 

• adloanListTranslations.xml in which all required translations of 
the fixed texts in the slips are or can be included, amongst which 
the name of your institution and possibly a contact e-mail ad-
dress. An e-mail address will be printed in large underneath the 
institution name.  

You can edit all .xsl and .xml files in a text editor like Windows Note-
pad, Notepad++ or Visual Studio, to customize the design and fixed 

texts, for example, or to add the logo of your institution. Please see 
the “Programming XSLT stylesheets for Adlib” manual for information 
about how to edit these files properly. 

If you are still using the .rtf templates, then note that the text editor 
which is used for editing and/or printing the loan slips is the program 
associated in Windows with the .rtf file extension (e.g. Microsoft 
Word). If no program is associated with this extension, then the pro-



With View > Device properties you can set up serial barcode scanners, 
should that be necessary. (See Appendix 2: editing the print slips 
 Adlib Loans 

10 

gram will be used that is associated in Windows with the .txt exten-
sion (e.g. Notepad). If that is not present either, no issue slip will be 
printed; you won’t receive any notification of this. 
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Appendix  for more information about that.) 

Via Help > Contents you open the Adloan Circulation Help. The infor-
mation it contains is comparable to the chapter you are now reading. 
 

 

For most active entry fields, selected options or drop-down lists on a 
screen tab in Adloan, you can press F1 to show the relevant specific 

contextual Help topic. If there is no link to such a specific contextual 
Help topic, pressing F1 will open a more general Help topic. You can 

always browse the Help contents for other topics. 

 The status bar 

In the status bar at the bottom of the screen, Adlib displays details of 
the current session. 

 Pop-up menus 

A lot of functions in Adloan Circulation can be found in pop-up menu’s. 
A pop-up menu opens when you click the right mouse button. Which 
options are available in the pop-up menu depends on the context: 
don’t right-click just anywhere, but click an item you want to edit or 
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know more about. For instance, right-click a specific copy on loan af-
ter you’ve chosen a borrower. 
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5. Issuing items 

To issue items, open the Issues tab in Adloan Circulation, like in the 
fictitious example below. 

 

First, you have to enter or select the borrower number, of the borrow-
er to whom you are about to issue: 

• If you know the number by heart, you may enter it directly in the 
Borrower number entry field. After entry press Enter or Tab. 

• The Borrower number entry field is also a drop-down list. Click the 
downward pointing arrow beside the entry field to display a list of 
recently (in this session) used borrower numbers. If you just 

started a new session, the list will be empty. 

• If you don’t know borrower numbers by heart, you can look them 
up using the last name of the borrower. You may leave the Bor-
rower number entry field empty, or enter the first letters of the 
last name, and then click the arrow pointing to the right next to 
the entry field. A window opens with a list of borrower names; se-
lect the searched borrower by double-clicking it. The number of 
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the borrower is automatically entered in the Borrower number en-

try field. 
Note that up to a maximum of 100 records can be displayed in the 
list, and in there you can’t jump to the following or previous part 
of the list. If the searched record is not in (this part of) the search 
result, you’ll have to close the list window (by pressing Esc), and 

enter a (partial) search key consisting of more characters. This 
will reduce the search result volume, more likely including the 
searched record in the displayed list.  

Once the borrower number is entered, the other known borrower de-
tails are immediately filled in. For example, the Current loans field will 
display the number of copies still on loan to the borrower, and the 
Loans limit field will contain the maximum number of copies that the 

borrower is allowed to borrow.  
If applicable, Outstanding loan fees and Outstanding fines are shown 
in red beneath the Copy number entry field. 
Any copies on loan appear at the bottom of the screen in the Current 
copies on loan list. 

To lend an item to this borrower, you’ll have to enter a number in the 
Copy number entry field. You can look up copy numbers by means of 
words from the title of the item. In the Copy number entry field, enter 
(the first letters of) a word from the desired title, and then click the 
arrow pointing to the right next to the entry field. You cannot search 
on an empty key. A window opens with a list of titles; select the 

searched title by double-clicking it. Now the number of that copy is 
automatically entered in the Copy number entry field.  
Note that up to a maximum of 100 records can be displayed in the 
list, and in there you can’t jump to the following or previous part of 
the list. If the searched record is not in (this part of) the search result, 
you’ll have to close the list window (by pressing Esc), and enter a 

(partial) search key consisting of more characters. This will reduce the 
search result volume, more likely including the searched record in the 
displayed list. 

If loan fees are due for a copy to be issued, you’ll receive a message 
of this. If you click Cancel in that message, the selected copy will not 
be issued. If, on the other hand, you click OK, the borrower agrees to 

the loan fee and the copy is lent out. 
In the Loan fee column in the Current copies on loan list, for each is-
sued copy the payable loan fee is indicated. The Outstanding loan fee 
(in red) will be adjusted automatically when new copies are issued. 
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5.1. Current copies on loan 

When the copy number has been filled in, the copy, with accompany-
ing details, is added directly to Current copies on loan. This data is 
shown in bold to distinguish newly issued copies from previously is-
sued ones. 

Under Current copies on loan, symbols at the beginning of each line 
indicate the loan status of the copy: 

Symbol Colour Meaning 

 Black The copy is on loan. 

 Yellow The copy is due today. 

 Red The copy is overdue. 

5.2. Issue slips 

You may print issue slips for a borrower by selecting the issued copies 
and choosing the desired print option in the pop-up menu: 

1. In the Current copies on loan list, select one or more copies. (To 
select more than one line, select one of the copies, then keep the 
Ctrl key pressed down while you click the other copies to be se-

lected.) 

2. Right-click one of the selected copies to open the pop-up menu for 

it. 

3. Depending on whether you have selected one or more copies, at 
the bottom of the pop-up menu you may choose from Issue slip 
for <copy number> or Issue slip for selected items (one slip for 
each selected copy), and Overall issue slip (one slip for all copies 
borrowed by the borrower together). For selected copies you can 
also start these functions without the pop-up menu, with the func-
tion keys F7 and F8. When you keep the Shift key pressed down 

while choosing an option, the issue slip will be opened in a text 
editor, but won’t be printed yet; this way you can edit the issue 
slip before you print it from within the text editor. 

See “Appendix 2: editing the print slips” for information about how to 
change the contents and layout of these slips.  
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5.3. Options in the pop-up menu 

When you right-click a copy in the list, a pop-up menu opens. The fol-
lowing options may appear in that pop-up menu (in the menu the x is 
replaced by the relevant borrower, copy or catalogue number): 

Option Meaning 

Borrower x properties Shows the properties of the borrower. 

Copy x properties Shows the properties of the selected 
copy. 

Catalogue x properties Shows the properties of the catalogue 
number belonging with the selected 
copy. 

Change x due date Change the due date for the selected 
copy. 

Change x due time Change the due time for the selected 
copy. 

Renew item Renew selected item. 
Return item Return selected item. 

Payments Process fines, loan fees and subscrip-
tion fees. 

Issue slip for x or 
Issue slips for selected cop-

ies 

Print an issue slip for each selected 
copy separately. 

Overall issue slip Print an issue slip stating all issued 
copies. 

 
The details shown under ... properties will be discussed in chapter 9. 
Payments will be discussed in chapter 10. 
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6. Returning items 

To return an item in Adloan Circulation, go to the Returns tab. 

 

Before you can return a book, its copy number must be entered (after 
manual entry press Enter or Tab). If you don’t want to enter it man-

ually, or if the copy number is unknown, you can look up copy num-
bers by means of words from the title of the item. You can look up 
copy numbers by means of words from the title of the item. In the 
Copy number entry field, enter (the first letters of) a word from the 
desired title, and then click the arrow pointing to the right next to the 
entry field. You cannot search on an empty key. A window opens with 
a list of titles; select the title to be returned by double-clicking it. Now 
the number of that copy is automatically entered in the Copy number 

entry field.  
Note that up to a maximum of 100 records can be displayed in the 
list, and in there you can’t jump to the following or previous part of 
the list. If the searched record is not in (this part of) the search result, 
you’ll have to close the list window (by pressing Esc), and enter a 

(partial) search key consisting of more characters. This will reduce the 
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search result volume, more likely including the searched record in the 

displayed list. 

As soon as you have entered the copy number, all other known details 
will be filled in on the screen. If a book is returned after the due date, 
you will be notified through a message. This message also indicates 
by how many days the book was overdue when returned and (if the 
Loans module is configured for this) the fine that is to be paid. Also, 
the copy will be added to the list of Returned items for this borrower. 
(As soon as you’ve registered the returning of a copy from a different 
borrower, you automatically start with a new list.) 

When, after issuing you switch to the Returns tab, or after returning 
copies from one borrower you want to start returning copies from a 

different borrower, you’ll notice that the Returns tab still has the bor-
rower number from the previous borrower and his or her outstanding 
payments on it. You cannot remove this borrower number here, so 
you could start with an empty tab. But that is not necessary really. 
Just register the returning of the copy via its copy number, and the 
associated borrower number will then be looked up automatically. So 
your data won’t get corrupted. 

A (passport) photo which you linked to a borrower in Adlib Loans 
management, will be shown on every tab in Adloan Circulation 4.2 
when you select the relevant borrower. (Older applications may have 
been customized to offer this functionality too.) 

 

6.1. Returned items 

As soon as a copy has been returned, details such as Due date (not 
the actual return date) and Fine for the copy will appear in the Re-
turned items list. Other returned copies from that borrower appear in 
the same list. When you return a copy from a following borrower, de 
previous list is emptied and a new one starts automatically.  
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At the beginning of each line there is a symbol that indicates the sta-

tus of the returned item: 

Symbol Colour Meaning 

 Black The item has been returned. 

 Red The item was overdue when returned. 

 Green The item has been returned and is awaiting 
collection by a reader who has reserved it. 

 Red The item was overdue when returned, and is 
awaiting collection by a reader who has re-
served it. 

 
If a fine is owed for a returned item, you will receive a message noti-

fying you of this. In the Fine column, the outstanding fine is shown for 
each copy. The Outstanding fines are adjusted automatically too. 

6.2. Options in the pop-up menu 

When you right-click a copy in the list, a pop-up menu opens. The fol-
lowing options may appear in that pop-up menu (in the menu the x is 
replaced by the relevant borrower, copy or catalogue number): 

Option Meaning 

Borrower x properties Shows the borrower properties. 

Copy x properties Shows the properties of the selected 
item. 

Catalogue x properties  Shows the properties of the catalogue 
number belonging with the selected 
copy. 

Payments Process fines, loan fees and subscrip-
tion fees. 

Return slip for x Print a return slip for each selected 
copy separately. 

Overall return slip Print a return slip stating all returned 
copies. 

 

The details shown under ... properties will be discussed in chapter 9. 
Payments will be discussed in chapter 10. 
 
See “Appendix 2: editing the print slips” for information about how to 
change the contents and layout of return slips. 
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7.  Reserving items 

In Adloan Circulation, reservations are entered and cancelled using 
the Reservations tab. 

 

To reserve a copy or a title, you must enter the borrower number and 
the copy or catalogue number. If you type these numbers directly in 
the entry fields, then press the Enter or Tab key after each entered 

number. 

You can search on a borrower name by entering the first letters of the 
last name in the Borrower number entry field, and clicking the button 
with the arrow pointing right. Select the desired name in the list that 
opens, by double-clicking it. The appropriate borrower number will 

automatically be inserted in the entry field. 
Similarly you may enter (the first letters of) a word from the desired 
title in the Copy id or Catalogue id fields; then click the button next to 
it to open a list of titles. (You cannot search on empty keys.) From 
this list you select the title you are looking for, after which the associ-
ated copy number or catalogue number is inserted in the entry fields. 
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Note that up to a maximum of 100 records can be displayed in the 

list, and in there you can’t jump to the following or previous part of 
the list. If the searched record is not in (this part of) the search result, 
you’ll have to close the list window (by pressing Esc), and enter a 

(partial) search key consisting of more characters. This will reduce the 
search result volume, more likely including the searched record in the 
displayed list. 

7.1. Reserving items on copy number 

As soon as the borrower number and the copy number have been en-
tered, the copy with the accompanying details is added to the Items 

currently reserved list. 

7.2. Reserving items on catalogue number 

If you want to reserve items on catalogue number, you can also enter 
the location and (loan) category, after you filled in the borrower num-
ber and catalogue number. Reservation will then take place in a spe-
cific branch and/or a specific loan category. A hyphen (the default val-
ue) means that it is not necessary to reserve an item at a specific lo-
cation or in a specific loan category. Click a field with a hyphen in it to 
fold out the drop-down list and select one of the available options. 

Important: since Adlib doesn’t know whether you would like to ac-
cept the default values in the At location and In category entry fields 
for the current reservation, or if you want to change them, a reserva-
tion will not be made until you confirm the selection in the In category 
entry field by activating that field, possibly choosing a different value 
from the drop-down list, and then pressing Enter or Tab. 

The In category entry field can be made active in two ways: you can 
click it with the mouse pointer or, if one of the entry fields above it is 
still active, by pressing the Tab key one or more times. (Each time 

you press Tab, the “focus” will go to the next entry field.) 

So when, after looking up a Catalogue id, you want to accept the de-

fault values in the next two entry fields and create the reservation 
immediately, you’ll only have to press Tab twice. 
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7.3. Reserved items 

As soon as the borrower number is known, the details of all previous 
reservations will be shown in the Reserved items list. New reserva-
tions are automatically added to the Reserved items when you enter 
them; the new details are displayed in bold type to distinguish them 
from previous reservations. 

At the beginning of each line there are symbols to indicate the status 
of the reservation: 

Symbol Colour Meaning 

 Black The copy/catalogue number has been re-

served. 

 Green The reserved item is available and awaiting 
collection by a reader. 

 Yellow The reserved item is available and awaiting 
collection by a reader. The expiry date of the 
reservation is today. 

 Red The expiry date of the reservation has passed. 

7.4. Options in the pop-up menu 

When you right-click a copy in the list, a pop-up menu opens. The fol-

lowing options may appear in that pop-up menu (in the menu the x is 
replaced by the relevant borrower, copy or catalogue number): 

Option Meaning 

Borrower x properties Shows the properties of the borrower. 

Copy x properties Shows the properties of the selected 
copy. 

Catalogue x properties Shows the properties of the selected 
catalogue number or the catalogue 
number belonging with the selected 
copy. 

Cancel reservation or Can-

cel selected reservations 

The selected reservation(s) is/are can-

celled. 
Payments Process fines, loan fees and subscrip-

tion fees. 
Reservation slip for x or 
Reservation slip for selected 
items 

Print a reservation slip for each select-
ed copy separately. 

Overall reservation slip Print a reservation slip stating all re-
served copies. 
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The details shown under ... properties will be discussed in chapter 9. 
Payments will be discussed in chapter 10. 

See “Appendix 2: editing the print slips” for information about how to 
change the contents and layout of reservation slips. 

7.5. Cancelling a reservation 

You may cancel any reservation by selecting a reservation, pressing 
the right-hand mouse button and then selecting the Cancel reserva-
tion option. Alternatively, you may select a reservation and press De-

lete. You will not be asked for confirmation in either case. 
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8. Messages 

During issuing, returning and making reservations, messages may 
appear to notify you of all kinds of matters concerning the current 
borrower, the copy, or the catalogue item. This means messages 
about overdue returning, outstanding fines, loan fees, etc. Depending 
on settings that you or your application manager have made for deal-
ing with messages, in the message you may choose to continue with 
the transaction you were about to execute, or cancel it, and whether 
you want to suppress this type of messages for the time being or not. 

 

In Adloan Circulation these messages are called “detailed messages”, 
to distinguish them from information in the lists Current copies on 
loan, Returned items, and Items currently reserved, which in fact also 
comprises messages and notifications about outstanding fines, over-
due returning, copies to be collected, etc. 

8.1.  Types of messages 

There are two types of messages: standard messages and special 
messages. Both are generated by Adlib automatically whenever it is 
appropriate, but you must provide the text of special messages your-

self, while texts of standard messages are provided only once by your 
application manager, in certain Adlib text files. 

 Special messages 

For any specific borrower or copy, you may create a message that will 
appear every next time a transaction for that borrower or copy is car-
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ried out. Think of occasional messages such as “Borrower still has to 

show his student card.” or “Write this copy off after returning.”  

You can create such a message quickly if you have already entered 
the concerning borrower number, or when one of the lists at the bot-
tom of the tab sheets already displays the concerning copy so you can 
select it. Right-click a line in such a list, for the current borrower or 
which displays the desired copy. Depending on what you want to cre-
ate a message for, you choose either Borrower x properties or Copy x 
properties in the pop-up menu that opens. A Properties… window 
opens, with on the first tab (General) the Message entry field and the 
drop-down list Type. Enter the appropriate text in the Message field. 

Click the Type drop-down list and choose the type of this message. 

The available types are listed in the table below (“codes” are used for 
standard messages). 

Type Code Result 

ignore 1 The message will not be displayed. 
delay 2 The message will be displayed after the 

transaction. 
message only 3 The message will be displayed before or dur-

ing the transaction. Click OK to continue. 
ask confirma-
tion 

4, 5 The message will be displayed in advance, 
with a choice between OK and Cancel. Click-
ing Cancel aborts the transaction. 

abort 6 The transaction is not carried out. The user 
must click OK to proceed. 

 
For instance, if an already registered borrower is not allowed to lend 
or make reservations yet, before he has shown a valid ID, you might 
choose the ask confirmation type. 
And if a copy is being repaired and therefore unavailable for an unde-
termined period of time, you could choose the abort type. When the 
copy is available again, you must remove the message though. You 
may do that by opening the Properties… window for this copy again, 
and then simply remove the text from the Message entry field. 

 Standard messages 

The texts for standard messages, and their type, are determined in 
the adloan#.txt files (in which # is an Adlib language number). So for 
the English language adloan0.txt is used. You can find this file in the 
Adlib Software subfolder in which the executables reside: this may be 
\bin or \executables for example. Double-click this file in the Explorer 
and Windows opens it in Notepad. 
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When the Adlib software generates a message, in this text file a 

(fixed) text number is located to display its text in the message. So 
you can’t change text numbers or add new ones. You can change the 
spelling or choice of words of a text though, as long as you keep the 
tenor intact. The main reason for opening this file probably is to as-
sign a different type to several messages. (In the table on the previ-
ous page you’ll find the code for each type.) In the text file, codes are 
stated between the text number and the text. At the top of this text 
file you’ll find some more information. 

For safety, create a backup of this file before you start editing. 

8.2. Suppressing a message 

Several types of messages can be suppressed, which means that you 
can indicate for such a type that you wish not to see these messages 
temporarily. 

 

In the lower left corner of a message you’ll see the Show detailed 
messages checkbox if that message can be suppressed; the checkbox 
has been selected. If you don’t want see this type of message any-
more as long as you are working on the current tab in Adloan Circula-
tion, you’ll have to deselect this checkbox. As soons as you switch 
tabs, or start a new session, this setting is annulled, and all messages 

will be displayed again. 
You can use this during the returning of copies for example, to sup-
press messages about reserved copies that can be collected. 
Note that when the Show detailed messages checkbox is greyed out, 
you cannot suppress this type of message. 
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 Messages that can be suppressed 

Of the special messages all types can be suppressed, with the excep-
tion of the abort type. This is because the transactions during which 
such a  message occurs won’t be completed, and the user needs to be 
notified of that. 

Of the standard messages only the following types can be suppressed: 

Text number Text 

398 Copy x is overdue by y days. 

399 Copy x is overdue by y minutes. 

411 The loan fee for copy x is y. Continue? 

412 Borrower entitlement exceeded for reservations. Re-
serve anyway? 

413 Borrower entitlement exceeded for reservations in loan 
category x. Reserve anyway? 

424 Borrower x has reservations to be collected y. 

437 Copy x is y days overdue. Fine amount is z. 

438 Copy x is y minutes overdue. Fine amount is z. 

444 Borrower entitlement exceeded for all items on loan. 
Continue? 

445 Borrower entitlement exceeded for loan category x. 
Continue? 
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9. Properties 

9.1. Viewing properties 

Right-click a copy number/title in a list on one of the three tabs in Ad-
loan Circulation, of which you want to view the properties. At the top 
of the pop-up menu that opens you may choose from: Borrower x 
properties (through the borrower number), Copy x properties 
(through the copy number), and Catalogue x properties (through the 
catalogue number). Depending on the context, one or more of these 

options may be unavailable; those will be greyed out. 

 

After you have chosen one of said options, the Properties for… window 
opens with a few tab sheets.  

 Borrower properties 

There are five tabs with properties of the selected borrower: 

• General: includes borrower name, borrower number and borrower 
category; 

• Subscription: details about the subscription; 
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• Counters: numbers of borrowed items, reservations and, per loan 

category, current items on loan and reservations; 
• Items: details about copies currently on loan or reserved; 
• Payments: information about loan fees and fines. 

 Copy properties 

There are three tabs with properties of the selected item: 

• General: here, you will see the title, and the copy and catalogue 
numbers; 

• Borrowers: details about the current and previous borrowers; 
• Counter: figures relating to the number of loans and reservations 

of this item. 

 Title properties 

There is only one tab (General), with properties of the selected cata-
logue number, such as the title and associated copy numbers. 

9.2. Editing properties 

The only entry fields in the Properties for… window that you can edit 
are Message and Type, to enter special messages for a copy or bor-
rower (see chapter 8). The information in the other, grey entry fields 
here can only be viewed, not edited. 
The only way to edit certain properties of borrowers and copies in Ad-

loan Circulation, is by actually carrying out transactions on one of the 
tabs Issues, Returns, or Reservations via the entry fields or via the 
options in the pop-up menu for a copy, which can be opened by right-
clicking an item in one of the lists. 
Other properties of borrowers, titles and copies, can be edited in 
Loans Management (see chapter 11) or in your Library application. 
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10. Payments 

If the current borrower has outstanding fines, or is indepted loan fees 
or contribution, in Adloan Circulation automatically the Payments for 
borrower … window for processing those debts opens, when you enter 
a new borrower or switch tabs. A more comfortable way of opening 
that window is to simply press F6 if you have entered the concerning 

borrower (and pressed Tab or Enter), or to right-click an item in one 

of the three lists for this borrower, and choosing Payments in the pop-
up menu that opens. 

In the Payments for borrower… window you’ll find three tab sheets: 

Fines, Loan fees, and Subscription. Open a tab to view the payable 
sums in that category. Most fields are calculated automatically and 
you can’t make any changes in those directly. Only when there actual-
ly is an outstanding sum, then in the Paid entry field you can enter the 
amount the borrower is now handing over or that has been credited to 
the account. (This amount need not necessarily be the entire sum.) 
After entering the payment, click Apply to deduct it from the out-
standing fine, the loan fee or the subscription fee (depending on the 
tab on which you enter the payment). Click OK to close the window. 
(After entering the payment you may also click OK directly to deduct 
the amount, and close the window simultaneously.) 
Before or after entering you may click Cancel to close the window 

without registering a payment. If, after entering, you already clicked 
Apply though, this transaction won’t be annulled by clicking Cancel. 

Instead of registering a payment you may also acquit the borrower 
from an outstanding fee or fine by selecting the Waive checkbox. Click 
OK to erase the outstanding sum. 
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11. Loans Management  

 

As explained earlier, Adlib Loans offers two interfaces: 

• From those two, Adloan Circulation is the dynamic variant to reg-
ister loan transactions such as issuing, returning, making reserva-
tions and processing payments, as typically is handled by an em-
ployee behind a customer desk. This interface is discussed in the 
first half of this manual. 

• The second interface is called Loans Management (or Circulation 
Management in older applications). This is a typical Adlib applica-
tion interface, like you may already know from Adlib Library or 
Adlib Museum. Through Loans Management it’s possible to main-

tain all databases of Adlib Loans; so the transactions you carry out 
in Adloan Circulation, are stored in there as well. Additional to ed-
iting that transaction data, you use this interface a/o for the regis-
tration of borrowers, the definition of loan limits, and for checking 
files and records in the event of a failure to process a transaction. 
Here, you may perform all typical Adlib functions on database rec-
ords, like making specific selections of records for overviews or for 
changing or replacing certain data, for performing checks, and 
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flexible printing. See the general Adlib User Guide, for a full ex-

planation of this standard Adlib functionality. 
In this chapter you’ll find information on what can be registered in 
Loans Management, and where. Note that help on files and fields 
is available in the application interface itself, by selecting an item 
or placing the cursor in an entry field, and pressing F1. 

WARNING: the files you may edit in Loans Management, are also 
used by Adloan Circulation to register transactions. If certain fields are 
freely edited or records are freely deleted from the files, registration 
may be disturbed, causing Adloan Circulation to no longer have access 
to the correct data.  
Therefore, please make sure that data or a record is not part of an 

open transaction, before changing or deleting it. 

For adding or editing catalogue titles or objects, use your full Library 
(Catalogue Management) or Museum application. 

11.1. Using shortcuts 

Start Loans Management by (double)-clicking the appropriate icon (a 
shortcut to Adlib Loans Management) on your Desktop or in the Win-
dows Start menu. 

Technical information 

The Target in this shortcut must be the path to adlwin.exe, and for 
Start in the path to your Adlib \wadcirc or \library loans management 
folder should be filled in. See the installation guide for your applica-
tion for more information about creating shortcuts. 

11.2. Choosing a data source 

After starting Loans Management, the Search wizard opens. Here, 
your first step is to choose a database or dataset to work in, or direct-

ly execute an option (for instance a print task). In the rest of this 
chapter each item from this list will be discussed separately. 
 

11.3. Borrowers 

Choose the Borrowers data source to register new borrowers or edit or 
view existing borrower details. You can search for existing records 
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using the access points (borrower) Number, Name, Borrower catego-

ry, Class/department, Place, Postal code, Subscription end date, Al-
ternative number and Record number. 

The Borrowers data source refers to the BORROWER database. This 
database is used in the Loans module, as well as in the Serials module 
(as the Readers data source) and the Acquisitions module (as the Re-
questers data source), and therefore a borrower may be a reader, a 
borrower and/or a requester all at the same time. So, personal details 
registered here, are shared between these modules. 

Click  to register a new borrower. The Personal details tab opens. 

11.3.1. The Personal details tab 

 

 User number 

A mandatory field. Enter a number for the borrower. Numbers cannot 
be generated automatically. If you give a borrower a bar code, you 
can also enter the borrower number by scanning in the bar code. 

 Site 

The branch at which the borrower is registered. 
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 Name, Title and Initials 

Enter the details as they are to appear for instance on a reminder. 
Name is a read-only field which is put together by Adlib at the mo-
ment you save a reader record. The composition is as follows: the 
format Surname, Initials Insertion is preferred, so for instance 

Winkel, R. van. If no initials are available and a first name is, then it 
becomes Surname, First name Insertion, so for example Winkel, 

Rupert van. If no first name is available either, then this reader is 
probably an institution and the Surname suffices as Name. 

 Class / department 

If relevant, enter the class or department to which the borrower be-

longs. 

 Borrower category 

Mandatory field. You can fill in one of the categories defined for your 
library. 

 Registered since 

Adlib will fill in the system date here, but you may also choose anoth-
er date. 

 Image 

Here, you can create a link to an image, for instance a photo of the 
borrower. Choose Edit > Finding image file to select a file. This photo 
will be displayed in Adloan Circulation 4.2 when issuing, returning or 
reserving items. See the general Adlib User Guide for more infor-
mation about the use of images. 

 ID number and type 

In ID-number you can enter a passport or other identification number 
like that of a driving license or public transportation card for instance, 
should it be required. 
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11.3.2. The Addresses tab 

 

 Address 

In Address type, on the Adresses tab, you indicate whether the ad-
dress is “home” or “workplace”. If it is a postal address as well (either 
with or without a P.O.Box number), then mark the Postal address 
checkbox. In Address, just enter the street name or “P.O.Box”. So, in 

House number a P.O.Box number may be entered as well. In some 
countries, on letters the house number must be printed in front of the 
street name and/or the postcode in front of the city name. Mark the 
relevant checkboxes if this is the case. 

 Telephone 

In the repeated field group Telephone you can enter multiple tele-
phone numbers, and not necessarily just of telephones. In Telephone 
type you specify which device is linked to the number: you can choose 
from “landline”, “mobile phone” and “fax”.  

 E-mail address 

If desirable, fill in the e-mail address of the borrower. After you save 
this record, Adlib will place mailto: in front of the address and under-
lines it. This means that when you click the e-mail address, your e-
mail program opens and you can write and send an e-mail to this ad-
dress directly. 
If here an e-mail address has been registered for the borrower, any 
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reminders can be sent by e-mail automatically. On the Letters tab you 

can set the way reminders are sent. 

11.3.3. The Subscription tab 

On the Subscription tab library fee details are registered. 

  

 Expiry date 

Here you may choose any desired future date. If you leave the Expiry 
date empty, Adlib will set this date automatically to the current date + 
365 days, during saving of this record.  

Technical information 

If you wish to use a default period different from 365 days, you must 
change the value assigned to the loanperiod in the borrstor.ada adapl 
source code (in the \adapls subfolder) from 365 to the desired num-
ber of days; then you have to compile this adapl, and copy the new 
borrstor.bin file to your \adapls or \data folder (dependent on where 
the file is located). 
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11.3.4. The Messages and free fields tab 

 

 Message + Message status 

This concerns a message that must be generated by Adloan Circula-
tion when this borrower number is used in a transaction. What you 
choose for Message type determines how the Loans module deals with 
this message. You have the following possibilities: 
 

Status Result 

Ignore The message won’t be displayed. 
Delay The message will be displayed after the transac-

tion. 

Message only  The message will be displayed before or during 
the transaction. Click OK to continue. 

Ask confirmation The message will be displayed in advance, with a 
choice between OK and Cancel. If you click Can-
cel the transaction will be aborted. 

Abort The transaction is not carried out. The user must 
click OK to continue. 

 Field type and Content 

The Field type and Content fields are useful in case you wish to regis-
ter some personal detail of readers, for which no applicable field is 
present. In Field type you then supply a name or short description of 
your new field and its contents can be entered in the Content field 

behind it. 
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11.3.5. The Letters tab 

The Letters tab looks as follows: 

 

 Reservation notification 

On the Letters tab you can link two types of letters to this user. This 
tab is used in both the Acquisitions and the Loans module, but in the 
Loans module only the Reservation notification letter is relevant. In 
this field, you set which letter record from the Letters data source 
must be used for this borrower. Reservation notifications cannot be 
printed to Word templates or sent by e-mail.  

Place the cursor in an entry field, and press Shift+F4 to display a list 

with available letter names. You may choose one from it. If you press 
F10, you may create a new letter name and letter text immediately, 

in the linked Letters file. The link from this borrower record will be 
created immediately. 
If you leave fields empty, then on storage of the record those fields 
will automatically be filled with names of applicable standard letters. 

 Method (for reminders) 

The Method setting applies to reminders (and to order notifications in 
the Acquisitions module). You may choose to send reminders by e-

mail, to print them to a letter record or Word template, or not to pro-
cess them at all. 
For every existing and new borrower category for which the library 
wants to be able to send reminders, on the Remind policy tab of an 
opened record in the Borrower categories and limits data source, you 
have to indicate which letters are to be used for which reminders. See 
chapter 11.12 for more information about this. 
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Important information about e-mailing 

For e-mailing, an e-mail address for the current borrower should be 
registered. And your sender address and the name of your SMTP 
server must have been set in line numbers 278, respectively 192, in 
adlib#.txt files. 

11.3.6. The Issued / reserved tab 

On the Issued / reserved tab, you can see which copies a borrower 
has in his or her possession at a certain time, and which copies are 
reserved for that borrower. The information in the lower half of the 
form corresponds with the information that you see during a loans 

transaction when you request the borrower details. 

11.3.7. The Counters tab 

The Counters tab shows statistical details on the borrower. You may 
edit them if necessary. 

 

11.3.8. The Management details tab 

Adlib fills in these details automatically, and you cannot edit them. 

11.3.9. Viewing or editing an existing borrower record 

Select the Borrowers file in the file menu, and choose one of the ac-
cess points, for instance Number or Name. You may then enter the 
name or the number you are searching for as the index key. If you 
enter an incomplete index key, you will get a list of full names (or 
numbers), from which you can select the borrower you were looking 
for. The record opens with the tabs described above. You may view 
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the borrower’s details. Click the Edit record button to put the record in 

edit mode. 

See the general Adlib User Guide for a detailed description of standard 
Adlib functionality. 

11.4. Copies 

Adlib automatically updates the Copies database during the catalogu-
ing of titles. For each copy of a title, Adlib creates a copy record in 
which loans and reservations will be recorded. 

Normally, the Copies file needn’t be consulted or edited in Loans Man-

agement. Only in exceptional circumstances, for instance in the event 
of a system failure, you will want to edit the copy records in here. For 
example, to manually adjust the loan status or to enter the return 
date if that did not happen because of an error. 

After choosing the Copies file, you may search for specific copies using 
the access points, to view or edit those records. 

11.4.1. The Copy details tab 

The Copy details tab contains the following fields: 

 Copy number 

The unique number with which the copy can be retrieved. 

 Title 

The (abbreviated) title of the copy. This will be displayed on the tabs 
of Adloan Circulation. If the copy was created in the catalogue, the 
copy title will consist of the first title line. 

 Catalogue number 

The number of the title in the catalogue.  

 Copy status 

The status of the copy in circulation. Possible status codes are:  

• on loan • recalled 

• available • lost or stolen 
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• withdrawn • awaiting collection 

• temporarily withdrawn • in transit 

 
The status is changed automatically as a result of transactions in Ad-
loan Circulation. Here, you can alter the status code manually, if nec-
essary. For example, to temporarily take a copy out of circulation, 
change available into temp. withdrawn. 

 Loan category 

Each copy comes under one of the loan categories defined by the li-
brary. 

 

 Shelf mark 

A shelf mark can be entered for each copy in the catalogue. 

 Borrower 

If the Copy status is on loan (see above), the number of the borrower 
who currently has the copy will be shown. 
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 Issued on 

The date and time the copy was borrowed by the current borrower.  

 Return due before 

The date and time by which the current borrower should have re-
turned the copy.  

 To be collected by 

The borrower number of the borrower for whom the copy has been 
reserved. This field is used and automatically updated by Adloan Cir-
culation. It always goes together with the Copy status: awaiting col-

lection (see above). 

 Previous borrower 

When an item is returned, the number of the borrower returning the 
item is put in this field. 

 Returned on  

The date and time the copy was returned by the previous borrower. 

 Preceding borrower and Returned on 

The returning details of the borrower preceding the previous borrow-

er.  

 Message and Type 

A (special) message that is to be displayed and dealt with during 
transactions involving this copy. The type (ignore, delay, message 
only, ask confirmation, abort) determines the way the message is 
dealt with (see page 37 for an explanation of the different types).  
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11.4.2. The Acquisition | Insurance | History tab 

 

Here, you can find information about the purchase, insurance and 
ownership history of this copy. These details have probably already 
been registered during cataloguing of this copy in Adlib Library (since 

the Copies database is shared between both applications), but you 
may still adjust them here. 

You can display data entry instructions per field: put the cursor in the 
desired field and press F1 to open the Help. 

11.4.3. The Location and counters tab 

The Location and counters tab contains the following information: 

 Home site  

The name of the branch where the copy belongs.  

 Current site 

The branch where the copy is registered.  
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 Location notes 

In this field, you can state the location of the copy in more detail, e.g. 
‘room 25’ or ‘reading room’.  

 Reservations 

The number of borrowers who have reserved the copy. The reserva-
tions themselves are in a different database (see 11.7 and 11.8). 

 

 Renewals 

The number of times the copy has been renewed for the current bor-
rower. 

 Accumulated loans 

The total number of times the copy was lent. 

 Recalls 

The number of times that the current borrower received a recall (re-
minder) for the copy. 

 Last recall sent on 

The date on which the last recall (reminder) was sent to this borrow-

er. 
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11.5. Borrower categories and limits 

In the Loans module, each borrower comes under a borrower catego-
ry. Borrower categories often have names such as Junior or Adult. You 

may add a borrower category by entering a record in the Borrower 
categories and limits file. 

You can limit the number of loans and reservations for each borrower 
category. In addition, limits specific for the loan category can be set 
for borrower categories, for example to the number of copy reserva-
tions in the Comics loan category for the Junior borrower category. 

Fines calculation and reservation periods are also linked to borrower 

category and loan category. 

For each combination of borrower and loan category, you can set a 
fixed date and time for copies to be returned, if desired, regardless of 
the calculated return period. This option may be useful for course ma-
terial or when stocktaking, for example. 

The maximum numbers, periods and table names are collectively re-
ferred to as limits. 

So you define the borrower categories here in the Borrower categories 
and limits data source. And in the record of borrower category you 
specify one or more loan categories. Only the names of the loan cate-

gories  must be defined both in the Thesaurus of Adlib Library, as in 
Adlib Designer. Adloan Circulation uses the loan category names set 
via Designer, but when titles and copies are created in the catalogue, 
the program only accepts the loan categories set in Loans Manage-
ment: these probably have the same names. The detailed display of a 
record in Borrower categories and limits comprises four tabs.  

11.5.1. The Borrower categories / loan limits tab 

On the Borrower categories / loan limits tab you set the global limits 
for a borrower category. 

 Borrower category 

Borrower categories have unique names that are established by the 
library during installation of Adlib, and are registered in this field. 

 Subscription fee 

The number of units of money that a borrower in this borrower cate-
gory owes in subscription fees. 
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 Enrolment fee  

The number of units of money that a borrower in this borrower cate-
gory owes in enrolment fees. 

 Subscription period 

The period of time covered by the subscription fee. 

 

 Total loans 

The maximum number of loans (all types), regardless of loan catego-
ry. So this field holds the maximum number of objects that may be 
issued to a borrower, in all categories together.  

 Total reservations 

The maximum number of reservations (all types), regardless of loan 
category. 

 Reservations per type 

The maximum number of reservations per type, regardless of loan 
category. 

• Copy reservations : the maximum number of reservations on 
copy, regardless of loan category. 

• Title reservations : the maximum number of reservations on title 
(with or without branch), regardless of loan category. 
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• Location-specific : the maximum number of title reservations 

where a specific location is entered, regardless of loan category. 

11.5.2. The Limits per loan category tab  

 

The second (repeatable) group of settings concerns the limits per loan 
category for this group of borrowers. 

The Limits per loan category tab contains the following details: 

 Loan category 

Per loan category (which you defined in the Thesaurus of Adlib Library 
as a preferred term with domain (Term type): loan category) you may 
set limits here; for each loan category you’d like to set limits for, you 
have to add a field group occurrence. 

You cannot add or force new loan categories to the Thesaurus via this 
field. Names of loan categories have to be added to the Thesaurus of 
Adlib Library explicitly first (e.g. immediately after installation). Only 
after that, you can further specify these loan categories with the rele-
vant borrower categories on the Limits per loan category tab. 

 Maximum loans  

The maximum number of loans in this loan category. 

 Period 

The length of the loan period for this loan category. 
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 Time unit 

The unit of time for the loan period, the reservation period and the 
fines table of this loan category: days or hours.  

 Fixed return date and time 

The date and time by which all materials in this loan category must be 
returned. Useful for e.g. training materials. 

 Loan fee 

In this borrower category, the amount of money owed for a loan peri-
od in this loan category. 

 Deposit 

Any deposit, payable for materials in this loan category for the current 
borrower category. 

 Reservations on copy 

The maximum number of copy reservations in this loan category. 

 Reservations on location 

The maximum number of copy reservations/title reservations, stating 
the location (branch), in this loan category. 

 Reservation period 

The reservation period for copies/titles in this loan category. 

 Reservation fee 

Any reservation fee, payable for materials in this loan category for the 
current borrower category. 

 Order request fee 

Any fee, payable for the request to order a material in this loan cate-

gory for the current borrower category. 

 Fine table 

The name of the fine table to be used for materials in this loan cate-
gory. These tables are defined with Adlib Designer. 
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11.5.3. The Remind policy tab  

  

On this tab, you can specify the number of days after which reminders 
must be sent to borrowers in this borrower category. See chapter 

11.12 for all information about reminders.  

11.6. Statistics 

11.6.1. Statistics per day or per location 

Via the Statistics data source, you can view the counters that are up-
dated automatically for each combination of transaction type, borrow-
er category and loan category. You may consult the data via three 
access points: Date, Location and Record number. 

When you access data for a particular day or location, first the Statis-

tics summary tab will open. Here, you’ll find the total of counts for a 
certain day. 
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On the Day statistics tab, you’ll see the separate counts of the unique 

combinations of transaction type – borrower category – loan category: 

 

With the Print wizard you may print statistics from the days or loca-
tions marked in de brief display, in several ways. (See the general 
Adlib User Guide for more information about the Print wizard.) The 
following output formats are available to print statistics:  
 
Daily statistics loan statistics per day, per bor-

rower and per loan category. 

Daily statistics by borrower cate-
gory 

loan statistics per day, per bor-
rower category 

Daily statistics by material loan 
type 

loan statistics per day, per loan 
category 

Total statistics loan statistics over the selected 
period, per borrower category 
and per loan category 

Total statistics by borrower cate-
gory 

loan statistics over the selected 
period, per borrower category 

Total statistics by item loan type loan statistics over the selected 
period, per loan category 

 
Note that you can only print statistics correctly when you have defined 
less than 31 borrower categories and less than 31 loan catagories. 
When you do have more categories en you want to print statistics too, 
a special adapl will have to be written for this; ask the Adlib helpdesk 
for more information. 
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11.6.2. Statistics per language code 

Loan statistics (transactions per loan category and/or per borrower 
category) are created from the Statistics data source – with one ex-
ception: loan statistics per language code. These statistics are created 
in the Copies data source. This type of count is made using the loans 
counter in each copy record. If you want statistics over a certain peri-
od, you should set the loans counters to 0 at the beginning of that 
period. 

The counts are made on the basis of the value that is entered in the 
Language field in the catalogue record concerned. If this field is emp-
ty, the number of loans will be added to the value Unknown 
(Onbekend) in the resulting statistic. You create loan statistics per 

language code by following the steps below: 

 Setting loans counters to 0 

• Open the Copies data source in Loans Management. 
• Select all copies by choosing the access point Copy number, click-

ing Next two times, and then clicking All keys. All copies will be 
listed. 

• Mark all records by clicking the Toggle marks button. 
• Click the Print button, choose Create a report with a predefined 

output format, and select the Reset issue counters output format.  
• Click Finish and in the next window click the Preview button to 

start the process. Depending on the size of the Copies file, this 
might take a while. 

 Printing statistics per language 

• Open the Copies data source in Loans Management. 
• Select all copies by choosing the access point Copy number, click-

ing Next two times, and then clicking All keys. All copies will be 
listed. 

• Mark all records by clicking the Toggle marks button. 
• Click the Print button and select the predefined output format 

Loan statistics per language.  
1. Click Finish and in the next window choose the type of output 

(Preview on screen, print on paper or output to a file). If the Cop-

ies file is very large, it may take a while before you see the result. 
(If the loans counters are at zero, the output will be empty.) 
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11.7. Title reservations 

 

Choose Title reservations in Step 1 of the Search wizard to view de-
tails on reservations on title. There is one record for each reserved 

title, in which one or more reservations are registered. You can search 
records via the access points Borrower number, Catalogue number or 
Record number. 

After retrieving a reservation, the Reservation details tab appears. 
The details on this tab correspond with the fields and columns on the 
Reservations tab in Adloan Circulation (see chapter 7).  

The Type of reservation field contains either the designation GL (glob-

al: on catalogue number), LC (location specific: on catalogue number 

and location), TC (on catalogue number and loan category), or CT 

(category: on catalogue number and location and loan category) to 
indicate the type of reservation. 

11.8. Copy reservations 

Adlib maintains one record for each reserved copy. In that record, one 
or more reservations are recorded. You can search the records via the 
access points Borrower number, Copy number and Record number. 
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After retrieving a reservation, the Reservation details tab appears. 

The details on this tab correspond with the fields and columns on the 
Reservations tab in Adloan Circulation (see chapter 7). 

 

The Type of reservation field contains the designation CP (copy specif-

ic) to indicate the reservation is on copy. 

The Availability field contains the designation Y if the copy is available 

in the library, and N if it’s not. If available, it will be a copy that has 

been set aside for the borrower to collect. 

11.9. Fines 

If fines processing is on, the Loans module will create a record in the 
Fines data source for every borrower who still has fines to pay. You 
can access the fine records directly in Loans Management, via the ac-
cess points Borrower number, Copy number, Copy title and Record 

number. 

The fields on the Fine details tab in the detailed display of a record 
correspond with the fields in the Payments window of Adloan Circula-
tion (see chapter 10). 
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11.10. Loan fees 

 

If a loan fee is owed for a combination of borrower category and loan 
category, the Loans module will create a record in the Loan fees file 
when a loan takes place involving that borrower and loan category. In 
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Loans Management you can access the loan fees records directly, via 

the access points Borrower number, Copy number, Copy title and 
Record number. 

The fields on the Loan fee details tab in the detailed display of a rec-
ord correspond with the fields in the Payments window of Adloan Cir-
culation (see chapter 10). 

11.11. Letters 

In the Letters file you can view and modify body texts of plain text 
letters or create new letters. These letters can be used when remind-
ers and reservation notification letters are printed, although reminders 

can also be e-mailed of printed to Word templates. With the borrower 
details in the Borrowers data source, you specify which reservation 
notification letters must be used and which method must be used to 
send reminders (see chapter 11.3). The letters to be used for remind-
ers, and the accompanying reminder periods, can be set per borrower 
category in the Borrower categories and limits data source (see the 
following chapter). 

 

11.12. Reminders 

Adlib can print or send by e-mail multiple different, subsequent re-
minders. In the Loans module 4.2, the location of templates and/or 
the names of letter records must explicitly be entered on the Remind-

er policy screen tab in the Borrower categories and limits data source.  
You can save the letter texts in Adlib records and/or in Microsoft Word 
templates: examples of both are present in your application. The re-
mind procedure in application version 4.2 makes it possible to 
print/send reminders via Word templates, instead of as plain text. The 
result will then be laid out nicely. As application manager you have to 
choose how your co-workers will print or send reminders. 
On the Letters screen tab in the Borrower data source, you set wheth-
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er a borrower should receive reminders by e-mail or by post. In the 

first case you must of course provide an e-mail address for that bor-
rower and your Adlib system must be able to send e-mails. 

11.12.1. Setting up a remind policy step by step 

In the Loans module 4.2 the remind policy has to be applied as fol-
lows: 
 
1. Adlib Loans Management opens with Step 1 in the Search wizard. 

Select the Borrower categories and limits file and click Next. You 
can now search for existing borrower categories or enter new 
ones. 
 

2. On the Remind policy tab of an opened record in this database, for 
every existing and new borrower category for which the library 
wants to be able to send reminders, you have to indicate which 
letters are to be used for which reminders since for each reminder 
letter there should be a different body text. This way, you can 
make the third reminder more urgent than the first one, for in-
stance. It’s up to you how many reminders you set: more or fewer 
than 3 is perfectly possible.  
 

 
In the screenshot above you can see a simple example of a set up 
remind policy for borrowers within this borrower category. In the 
first occurrence of the Reminder period (days) field, you fill in the 
minimum number of days after the return date after which the 
first reminder must be sent. In the (optional) second and following 
occurrences of this field group you set the minimum number of 
days after the return date after which the second and following 
reminders must be sent.  
 

The repetitions of the Reminders field group will be sorted auto-
matically by the contents of the Reminder period (days) field. This 
ensures that the reminder letters are always in the correct order. 
 
A remind policy consists of at least one filled in Reminder period 
(days) with an accompanying Reminder letter (plain text). You can 
add further occurrences of this field group via the following but-
tons: 
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3. So, per field group occurrence you can fill in four fields in line, of 
which at least a reminder term and a plain-text letter (a record 
with plain text in the Letters database in this application). If you 
choose plain text only, like in the example of step 2 above, then 
first place the cursor in the first field of the line and type the name 
of the desired letter or accept the default name. (If you aren’t 
sure about the name, press Shift+F4 to open a list of available 

letter records, from which you can choose one or create a new 
one; existing letter records can be displayed in a zoom screen 

from the Linked record search screen by clicking the Details but-
ton. And if desired, you can click the Edit record button in the 
Adlib toolbar to immediately adjust the letter text.) If you do not 
provide Word templates in the same field group occurrence, then 
Adlib uses the text from the letter record to which you just linked, 
for sending reminders both per e-mail as for printing. But as soon 
as you also provide a Word template in a field group occurrence, 
Adlib will prefer this template over plain text.  
 

 
In contradiction to plain text, for which one record is used for both 
e-mail and printing, when using templates you have to use differ-
ent templates for e-mail and printing. You probably have some 
example templates, which you can adjust to your liking. (For more 
information about creating templates for use in Adlib, see the 
Adlib User Guide.) 
The path to the templates may be relative (relative with respect 
to the folder with the application name), like in the example 

above.  
Examples of Word templates are in the \Worddoc\templates-
subfolder in your Adlib Software folder: see the reminder… tem-
plates. Only adjust the fixed texts in the desired template to your 
own situation (you can do that in Microsoft Word), and save the 
file again with the .dot extension (not as .doc), and possibly under 
a different name. In this file, use fixed texts in the language in 
which you want send reminders via templates. 
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Save this borrower category record when you are finished with fill-
ing in the remind policy. 
 
Note that for an international borrowers file, borrower categories 
provide the possibility to set up a multi-language remind policy. 
Suppose most of your borrowers are English speaking, but some 
are from France, and you wish you serve them in French. Then 
just create a separate borrower category for this group and link 
French reminder templates to it.  

 Linking borrowers to a remind policy  

4. You have to fill in a borrower category for each borrower who 

must be able to receive reminders. You may want a different re-
mind policy for students than for co-workers for example, etc. You 
can do this in the Borrowers data source that you can select in the 
first step of the Search wizard. 

5. In the example below the (fictive) borrower category “ministries” 
has been assigned to this borrower.  
 

 

6. On the Addresses tab (see the screenshot below) you have the 
possibility to enter an e-mail address. Only if you entered an e-
mail address here, you can choose to send reminders per e-mail 
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to this borrower (to this e-mail address), otherwise you have to 

print reminders and send them by normal mail.  
 

 

7. Finally, on the Letters tab, you indicate how this borrower should 
receive reminders. (So for e-mail, an e-mail address must be reg-
istered.) This setting only applies to reminders, not to the notifica-
tion letters present on this screen. 
 

 
 

8. Make settings 4 up to and including 6 for each borrower in the 
database.  
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11.12.2. Reminder policy 

Adlib can generate multiple reminders. Depending on the values set 
for Reminder policy in the borrower category record in the Borrower 
categories and limits file and the date on which the book was due, 
Adlib calculates whether a reminder should be sent for the copy in 
question each time you start the reminder procedure. 

Reminders are put together per borrower and per reminder term. This 
means that all copies of a borrower for which reminder 1 must be 
made, will be printed on one letter. And all copies of that borrower for 
which reminder 2 must be made, will be printed together on a subse-
quent letter. This way, the character of the letter text is always appli-
cable to all copies in that letter. 

Reminders will always be sent in the correct order: a borrower can 
never receive reminder2 before having received reminder1, nor re-
minder3 before having received reminder2. So if you start print-
ing/sending reminders for the first time after a holiday of three weeks, 
and a borrower with an overdue book has not yet received a remind-
er, then he or she now receives reminder1 (even though the book is 
so much days overdue that normally already a second or third re-
minder would have been sent). On the other hand, if the library did 
sent reminder1 prior to the holiday, then now reminder2 will be print-
ed/sent, etc. Moreover, the difference between the set Reminder peri-
od for two subsequent letters will still apply for sending the next re-

minder. So, if the reminder terms are e.g. 7, 14 and 19, and after a 
holiday of three weeks you start printing reminders again on Monday, 
and repeat it on Wednesday, then a first reminder from Monday won’t 
be followed up by a reminder two after these two days. Only after 7 
(14-7) days you will be able to print reminder number two. 

If some time earlier a reminder was made for an overdue copy, but it 
isn’t known when that was done, then the same reminder will be sent 
again and the current date will be saved in the relevant copy record. 

In the Copies database, you can find out per copy how many remind-
ers (Recalls) already have been sent, and when the last one was sent. 
 

If a borrower has received the maximum number of reminders for a 
copy already, then no further reminders will be created, yet a warning 
appears on screen or that message will be registered in the log file. 
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For both the templates as the plain text letters it applies that if a bor-
rower has outstanding fines for copies which were returned too late in 
the past, then on every reminder letter also an overview of those fines 
will be printed. For copies which are currently overdue, no provisional 
fines will be calculated. Of course you can include a fixed text in your 
reminder letters, to remind the borrower about the fine per day or 
week which will be charged for overdue copies. 

Adlib doesn’t make invoices. Neither will Adlib bar readers who fail to 
return a book, even after repeated reminders. We find this action too 
drastic to be automatic. If you want such borrowers to be barred, you 
can specify this manually per borrower in the Borrowers file on the 

Messages and free fields tab, by providing a special Message (see 
chapter 8). 

11.12.3. System settings for reminders 

As application manager you’ll have to make some adjustments to 
Adlib text files, if you want to be able to send letters via e-mail; see 
the technical information below. Without those modifications, auto-
matic e-mailing won’t work. 
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Technical information 

In the adlib#.txt files, you’ll find extended system texts for all adapls 
together – # represents a language number: English (), Dutch (1), 
French (2), German (3), Arabic (4) and Greek (6); these files are lo-
cated in the \texts subfolder in your Adlib Software folder and contain 
all texts (per file in one language) that are used by all adapls. Some 
settings herein are (also) relevant for the remind procedure. 
 
Open each of these .txt files (or just the languages which you use) in 
Windows Notepad and apply the following changes (if still necessary): 
1. Behind line number 192, type the name of the SMTP server which 

should be used for sending e-mail. 
2. Behind line number 278, type the sender e-mail address, for ex-

ample the general e-mail address of your library. If the sender e-
mail address cannot be used as a reply e-mail address, then pro-
vide the reply e-mail address directly behind the sender and sep-
arate the two addresses by a semicolon without space. For the 
functionality of the extra reply e-mail address you do need 
evalsmtp.dll 7.5 (2018-04-30 version) or later. 

3. When sending reminders from the file menu in Adlib (the first 
step of the Search wizard), Adlib possibly generates a remind-
er.log file in the \wadcirc or \library loans management folder, in 
which any error message are saved (then the error messages 

won’t be displayed on screen). If you don’t want to save such a 
file, but wish to send it by e-mail to e.g. the application manager, 
then behind line number 1051 enter the e-mail address of that 
person or department. If you do not provide an e-mail address, 
then the file will be stored in the current application folder by de-
fault (\wadcirc or \library loans management), unless you have 
entered a different path and file name behind line number 1055; 
then the latter is considered the preferred location; all co-workers 
allowed to send reminders, should have write access to this folder 
 

Save each file after adjusting it. 

11.12.4. Printing reminders 

Reminders can be generated and printed or sent in three ways: 

 From the database menu in the Search wizard 

In the first step of the Search wizard you’ll find the Print reminders 
option (see the screenshot below). This is not a data source, but a link 
to an adapl program which checks for all copies on loan whether they 
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are overdue, and subsequently automatically prints or sends a re-

minder. (Processing a Word template takes a couple of seconds per 
overdue copy.)  
Double-click Print reminders (and in the following confirmation window 
click Yes) to start the procedure. 
 

 

 From the Copies file 

1. Search the copies for which you want to generate reminders, if 
necessary; for instance, you could select all copies in a certain 
loan category, of just select all copies from the catalogue. In the 
Brief display mark all copies you want to check for the necessity to 
send reminders. The copies you select don’t have to be on loan or 

overdue, as that will be checked during the reminder procedure 
before the reminders are created. So, if you have selected all 
available copies for instance, then only for actually overdue copies 
a reminder is created. 

2. Sort the selected copies on borrower number. This way, copies of 
a borrower for which the same reminder letter must be made are 
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placed on one letter. (See the Adlib User Guide for information 

about sorting in the Brief display.) 

3. Click the Print button to open the Print wizard. In it, choose Create 
a report with a predefined output format. In the next step of the 
Print wizard you’ll find a format for printing reminders, in the list 
with available output formats. Select it and click Finish. In the 
Windows Print window which opens, leave the Print to file, Send 
by e-mail and MS-DOS text options unmarked. Click OK, and 
Adlib automatically determines which reminders must be sent by 
e-mail and which must be printed. (See the Adlib User Guide for 
more information about the Print wizard.) 

 From the Borrowers file 

1. Search the borrowers for whom you want to generate reminders, 
if necessary; for instance, you could search all borrowers in a cer-
tain class, department or borrower category, or all borrowers 
whose subscription will expire on a certain date. In the Brief dis-
play mark all borrowers you want to check for the necessity to 
send reminders. The borrowers you select need not to be borrow-
ing anything nor need to have overdue books, as that will be 
checked during the reminder procedure before the reminders are 
created. So, if you have selected all borrowers for instance, then 
only for borrowers with overdue copies a reminder is created. 

2. Click the Print button to open the Print wizard. In it, choose Create 

a report with a predefined output format. In the next step of the 
Print wizard you’ll find a format for printing reminders, in the list 
with available output formats. Select it and click Finish. In the 
Windows Print window which opens, leave the Print to file, Send 
by e-mail and MS-DOS text options unmarked. Click OK, and 
Adlib automatically determines which reminders must be sent by 
e-mail and which must be printed. (See the Adlib User Guide for 
more information about the Print wizard.) 

11.12.5. If Adlib cannot process letters as instructed 

If in 4.2 applications a reminder cannot be made in the way indi-

cated in the remind policy (for instance because the templates are 
not in the right place), then Adlib will automatically check for oth-
er possibilities:  

• If Adlib cannot send an e-mail with an e-mail template, it uses 
a plain text letter if specified. If no plain text letter has been 
specified, a default letter text from an adlib.txt file will be 
used. 
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• If Adlib cannot print a reminder with a reminder template, it 

uses a plain text letter if specified. If no plain text letter has 
been specified, a default letter text from an adlib.txt file will 
be used.  

11.13. Print reservation notifications  

When a reserved copy is returned in Adloan Circulation, you’ll receive 
a message to keep the copy separate because it is reserved. If you 
also want to generate reservation notifications for borrowers to notify 
them of the copy awaiting their collection, you’ll have to do that man-
ually in Loans Management. Typically, you do this once per day or 

week.  
In the file menu (Step 1 of the Search Wizard) of Loans Management, 
choose the Print reservation notifications option to print a notification 
letter for each returned copy. After your confirmation, the notifications 
are printed immediately (without the Print wizard). (Of course, an ex-
isting notification letter must have been specified on the Letters tab in 
the Borrowers data source, for the borrowers for whom you wish to 
print these letters.) 
From June 2011, an update of the 4.2 adapl responsible for printing is 
available here. With the update, if the borrower has an e-mail ad-
dress, the notification will be e-mailed by default; otherwise, printing 
to plain text will proceed.  

The size of your database and the number of letters to be printed will 
determine how long the procedure of generating and printing notifica-
tions takes. During the procedure, the workstation cannot be used for 
any other purpose, so preferably perform this kind of procedures in 
the lunch break or at the end of the day, if you know from experience 
that printing takes a while.  

11.14. Take stock 

Adlib allows for you to take stock at regular intervals, and to print out 
reports on your stock-taking. Reports can be printed on an entire col-

lection, or parts of a collection, e.g. all copies in a certain loan catego-
ry or in a certain language. You can take stock as follows: 

 1. Make an inventory 

Take stock of the books present in the library. Use the Take stock op-
tion in the file menu of Loans Management. Click this option to open 
the Take stock window (Bezitscontrole). Subsequently, enter the copy 

http://www.adlibsoft.com/support/faqs/e-mailing-reservation-notifications
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numbers of all the books actually present in the library (or in the sub 

collection): each time, type a copy number and press Enter to put it 

in the inventory. If you have a bar-code reader, you may scan the 
bar-codes of the books.  
If you want to stop taking stock, do not enter another copy number 
and just press Enter. You can resume your stock-taking at any time. 

Do remember the date of the first day you started making this inven-
tory. 

 2. Generate a report about missing copies 

When you have made an inventory of all the books you wanted to 
take stock of, you may create a report on any missing copies. You can 
do this either from the Copies file in Loans Management, or from the 

Full catalogue or Books data sources in Catalogue Management (your 
Library application).  
1. In the file of your choice, make a selection corresponding with the 

collection that you made an inventory of (mark the records in the 
Brief display). For instance, if you have taken stock of the com-
plete collection, you can search for all records in the Full catalogue 
data source in Catalogue Management by searching for all in the 

search language. Double-click the search result to show the Brief 
display, and click the Toggle marks button to mark all records.  

2. Then start the Print wizard, select the Create a report with a pre-
defined output format option, click Next, choose the output format 
Compare with stock taking results and click Finish. Choose the de-

sired output destination. Adlib will now ask you to enter the date 
of creating the inventory, for instance 31/12/2003. If the stock-

taking was spread over several days, then enter the first day of 
stock-taking. After you’ve entered a valid date, Adlib will start 
searching for copies that do occur in the marked selection of rec-
ords from the catalogue or from the Copies file, but haven’t been 
included in the inventory because they are missing or were on 
loan. These will be presented in the form of a list; if a copy has 
been taken stock of, while its status on the day of printing the re-
port is On loan, this will be mentioned with the missing copy in 
the list. So it is important that books on loan aren’t returned be-
tween (the first day of) taking stock and printing the report, be-

cause they will appear in the report as missing (unless you stake 
stock of each returned book in that period separately). 

11.15. Stock-taking details  

Every stock-taking of a copy can always be retrieved via the Stock-
taking details data source in Step 1 of the Search wizard of Loans 
Management. With the access points you may search for Copy num-
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ber, Inventory date, or Record number. This way you can check how 

many copies were taken stock of at a particular day for instance, or 
you could check whether a specific copy has been put in the inventory 
already, or check at what date you started your current stock-taking. 

11.16. Loans history 

In the Loans history data source, the loans history of each copy is au-
tomatically saved per issuing, in a separate record. A single, past loan 
transaction will be displayed on the read-only Loan history tab. 
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12. Appendix 1: installing Adlib Loans 

The Adlib Loans software may be delivered to you in different ways. 
See the Installation guide for Adlib Library, Museum and Archive, for 
information about installing from cd, the directory structure of Adlib 
applications, and creating shortcuts to be able to start applications. 

After the basic installation, you’ll still have to configure Adlib Loans to 
set up the module for your system. 

12.1. Stand-alone or client/server 

You can run Adlib Loans as a stand-alone application or as a client in a 
client/server environment. 

• Stand-alone means you can have only one session active at a 
time; at any moment, on one pc, only one person may register 
loans. This could mean that you have all executable Adlib files, 
module files and databases on your own computer, but this is not 
necessary; those files and databases may also be located on a dif-
ferent computer in your network. However, all executable files will 
be handled by your own pc or workstation. 

• As a client in a client/server environment means that Adlib Loans 

will be started from workstations in a network, in which the work-
stations only carry out the executable file adloan.exe (which is re-
sponsible for the user interface of Adlib Loans), while only the 
server computer of the network runs the Adlib Loans server soft-
ware (adserver.exe and adserver.dll).This configuration allows for 
several sessions to be active simultaneously (on one or more 
workstations, and opened by one or more co-workers). 

 The physical location of files 

The place where you store (copy) your Adlib executable and module 
files can be chosen freely for both types of configuration (as described 
above), on the condition that the executable files (executables) reside 
in the same directory as adserver.dll, which by default is the \bin or 

\executables subfolder. The module files are usually located in another 
folder, for this module that is Adlib Software\wadcirc or \library loans 
management by default. 
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If you (also) use an Adlib Internet Server application to perform loans 

transactions, for instance to let users make reservations via the inter-
net, then you’ll have to store the Adlib executable files en adserver.dll 
in the wwwopac folder (this is the wwwopac folder from which your 
Internet Server application calls wwwopac.exe). 

12.2. Installing adserver 

The executable Adlib file adserver.exe takes care of the communica-
tion between the user interface of adloan.exe and Loans server soft-
ware adserver.dll, in a client/server configuration. Adserver.exe may 
be called by an Adlib Internet Server application as well, to communi-
cate with adserver.dll. 

(In a stand-alone situation adserver.exe won’t be used.) 

You have to install adserver manually, to allow to run it as a system 
service under the Services manager of your Microsoft Windows NT 
Server or Windows 2003 Server or higher. (If you run something oth-
er than Windows server software on your server machine, then ad-
server may also be installed under Windows Vista, XP or Windows 
2000 on one of the workstations.) To install adserver in the database 
of the Services manager, first open a (DOS) command prompt window 
from the computer where the adserver.exe file resides (search Win-
dows for cmd, right-click the found Command Prompt and select Run 

as administrator) and open the directory that holds adserver.exe. 
Then type a command line for the installation, that has the following 

syntax: 

adserver -install -workdir <full path to wadcirc or library loans 

management directory> 

for instance: 

adserver -install -workdir “\\servername\programs\adlib\library 

loans management” 

With this installation you also set the work folder for adserver. Subse-
quently, a message will appear in the command prompt window to 
indicate whether adserver has been installed successfully. Adserver 
has also been started up. After each reboot of the system, adserver 

will restart automatically. Still, if that is not the case, then possibly 
the startup type of the service might be set incorrectly. 
Start the Services manager by opening the Control panel, double-click 
the Administrative Tools icon in it, and double-click Services in the 
Administrative Tools window. In the Services manager you can view 
the startup type of this service behind Adlib z39.50 Services. If the 
startup type is Manual, you’ll have to change it to Automatic. For this, 
right-click Adlib z39.50 Services and choose the Properties option in 
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the pop-up menu. You can change the Startup type on the first tab in 

the …Properties window. 

The -workdir command-line option is only required once, for installa-

tion. The server will save this setting in the registry. 

In the special case in which a server hosts more than one web site 
and you want to set a different workdir for each application, you may 
set other workdirs manually (by executing regedit) in the Windows 
registry on the server where adserver.exe has been installed, below 
the base Workdir (in the path HKEY_LOCAL_MACHINE > SOFTWARE > 
ADLIB Information Systems > Adserver). Those keys must begin with 
“Workdir”, for example “Workdir2” or “WorkdirMuseum1”. From within 
an Internet Server web application a call to adserver.exe must then 

be augmented with the site= argument which must receive the se-

cond part of the extra workdir key behind the = character, so for in-
stance site=2 or site=Museum1. If you do not provide a site, the 

base workdir will be used. 
 

 
 
Note that incorrectly adjusting the Windows registry may have prob-
lematic consequences: only edit it if you know what you’re doing. 
 
Another manual addition to the Windows registry of the server is re-
quired if you want Internet Server users to be able to renew already 
borrowed items more than once. By default, an item can only be re-
newed once: on the second attempt, the online reservation page dis-
plays error message 5:  Copy #### has already been renewed # 
times. Online renewal is not possible. To change this, right-click the 

right panel (of the Adserver folder) and select New > DWORD(32-bit) 
or New > DWORD in the pop-up menu which appears. Name the new 
key NumberOfRenewalsAllowed (the name is case-sensitive). Then 

double-click the new key to open its properties (see the image below). 
For Value data, enter the number of renewals of any item that you 
want to allow. Subsequently click OK and close the Registry editor. 
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If you might want to remove adserver, open a (DOS) command 

prompt window and look for the directory that holds adserver.exe. 
Then type: 

adserver -remove 

This will stop the service and remove it from the database of the Ser-
vices manager. (You’ll have to reboot the computer before adserver 
can be installed again, if you wish to do so.) 

Any problems during startup will be logged in the Event viewer, which 
can be found in the Administrative Tools. 

 Rights for visitors of your Internet Server application 

If you have a web site on which an Adlib Internet Server application is 
running which has to be able to perform loans transactions, then you’ll 
have to assign the visitors of that web site certain rights. 
All (unknown) visitors fall under the definition of “anonymous user”. 
The “name” of the anonymous user (default: IUSR_<servername>) can 

be found in the properties of the virtual folder in which the Internet 
Server application runs. (See the Internet Server installation guide, 
for information about settings of the virtual folder.) 
In the Windows properties of the work folder for the loans module 
files, you have to set read-access rights for this IUSR. And in the 
\data folder of your Adlib system, you have to assign the IUSR write 
and edit rights. 

12.3. Settings for starting Adloan Circulation 

The most user-friendly way to start Adloan Circulation is by means of 
a shortcut. Some settings in that shortcut determine how Adloan Cir-
culation is started. See the Installation guide for Adlib Library, Muse-
um and Archive for general information about creating shortcuts. Sup-
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plementary to this general information, the following can be said 

about applicable command-line options and work folders: 

• The default language in which you wish to start Adloan Circulation, 
can be stated in the shortcut to this module interface with the 
command-line option -c <language number> behind the path to 

the Target (adloan.exe).  
For instance, “<path>\adloan.exe” -c 0 always starts the Ad-

loan Circulation in English. 
If, in the shortcut, no language is given, then Adloan Circulation 
starts in the language in which the interface was closed the last 
time. 

• If there are several loans applications present on the same com-

puter system, they will each have their own application directory. 
The directory in which a loans application is started (in the Start in 
entry field of the shortcut), therefore determines which application 
is started.  
(If you start up adloan.exe from a (DOS) command line, then be-
hind the executable you may enter an application directory 
through the command-line option -workdir or –w, followed by the 

full path to the application directory in between double quotes.) 

• If the computer on which you are working is also the server for 
Adloan Circulation (stand-alone configuration), then in the 
shortcut the command-line option -s must be entered.  

With this setting, in the Session parameters loggin-in window (see 
chapter 2) the computer name will automatically be entered in the 
Server entry field, because adserver.dll is located in the same di-
rectory as adloan.exe. In the Start in entry field in the shortcut, 
the path to Adloan Circulation should be filled in, for instance: 
“C:\Adlib Software\wadcirc”. 

• In a client/server configuration, you don’t have to fill in the Start 
in entry field in shortcuts to adloan.exe (to start it on work-
stations): this is because adserver already knows what the work 
directory is, since you provided that information when you in-
stalled adserver. And adloan.exe knows where adserver.exe can 
be found because you have to enter the name of the server com-

puter on which adserver as been installed in the Session parame-
ters logging-in window. To prevent co-workers from having to en-
ter the server name each time they log in, you may include it in 
the shortcut via the command-line option -h, for instance: 
…\adloan.exe -h ourlibrary.server 

• The location of the databases is specified in the module files. If 
you want to move those databases to a different location, that 
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means you’ll have to adjust Adloan Circulation through Adlib De-

signer. 

• With the command-line option -l you may provide the default 

location (branch), in the shortcut. 

• With the command-line option -u you may provide the default 

user name, in the shortcut. 

• With the command-line option -p you may provide the default 

password, in the shortcut, but be careful with this option. 

• With the command-line option -z you may provide a port number 

through which a client must access the server, if the server 

doesn’t run on the default port (210). In most cases you won’t 
need to use this option. 

• With the command-line option -o you indicate that your databases 

have been stored in the DOS character set, whilst you use ISO-
Latin1 in your applications; the Locale option in the Designer da-
tabase setup has been set to DOS (previously Convert OEM to ISO 
set to Yes). 

• With the command-line option -? you open a message that lists 

the available command-line options. 
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13. Appendix 2: editing the print slips 

 

From within Adloan Circulation you can print issue slips, return slips 
and reservation slips for the borrower, to remind him or her about any 
borrowed, returned or reserved copies. 

The contents of these slips (fixed texts and Adlib field references) are 
determined by special templates in the Adlib \executables folder, 
which you can edit.  
In old (pre-7.2) Adloan versions, these templates were made up by 
six types of .rtf files (you can edit these in WordPad): islipall#.rtf, 

islipone#.rtf, dslipall#.rtf, dslipone#.rtf, rslipall#.rtf and rslipone#.rtf, 
in which # stands for an Adlib language number (English = 0, Dutch = 
1, French = 2, German = 3, Arabic = 4, Italian = 5, Greek = 6, Portu-
guese = 7, Russian = 8, Swedish = 9, Hebrew = 10, Danish = 11, 
Norwegian = 12, Finnish = 13 and Chinese = 14).  
However, from Adloan version 7.2.15061.3 or 7.3.15065 six XSLT 
templates (which have more possibilities than the .rtfs), plus a single 
XML file containing fixed texts in different translations are used by 
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Adloan by default.  

If you start using a new Adloan version but you have no desire to use 
the XSLT stylesheets, then simply remove them from the \executables 
folder and store them in a backup folder somewhere else: Adloan will 
then revert to using the old .rtf templates. 
If you’d like Adloan to use the XSLT stylesheets, make sure the follow-
ing files reside in the Adlib \executables subfolder: 

• issue-list-all.xsl (replaces islipall#.rtf) to generate the Overall 
issue slip. 

• issue-list-one.xsl (replaces islipone#.rtf) to generate the issue 
slip for one or more selected copies. 

• return-list-all.xsl (replaces dslipall#.rtf) to generate the Overall 

return slip. 

• return-list-one.xsl (replaces dslipone#.rtf) to generate the re-
turn slip for one or more selected copies. 

• reservation-list-all.xsl (replaces rslipall#.rtf) to generate the 
Overall reservation slip. 

• reservation-list-one.xsl (replaces rslipone#.rtf) to generate the 
reservation slip for one or more selected copies. 

• adloanListTranslations.xml in which all required translations of 
the fixed texts in the slips are or can be included, amongst which 
the name of your institution and possibly a contact e-mail ad-

dress. An e-mail address will be printed in large underneath the 
institution name.  

You can edit all .xsl and .xml files in a text editor like Windows Note-
pad, Notepad++ or Visual Studio, to customize the design and fixed 
texts, for example, or to add the logo of your institution. Please see 
the “Programming XSLT stylesheets for Adlib” manual for information 
about how to edit these files properly. 

If you are still using the .rtf templates, then note that the text editor 
which is used for editing and/or printing the loan slips is the program 
associated in Windows with the .rtf file extension (e.g. Microsoft 

Word). If no program is associated with this extension, then the pro-
gram will be used that is associated in Windows with the .txt exten-
sion (e.g. Notepad). If that is not present either, no issue slip will be 
printed; you won’t receive any notification of this. 

 

http://www.adlibsoft.com/support/manuals/maintenance-guides/programming-xslt-stylesheets-for-adlib
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14. Appendix 3: device properties 

In Adloan Circulation you’ll find the Device properties option in the 
View menu. (In other Adlib applications you’ll find this function in the 
Options menu.) For the current application, in here you can make set-
tings for serial (barcode) scanner devices connected to your comput-
er, and of which you want to import the output into Adlib. (USB scan-
ners that emulate a keyboard need not be set up here, you can enter 
data with them immediately.) 

1. Choose View > Device properties to open the settings windows 
with the same name. There are four COM# tabs. This means that 

up to four scanning devices (connected to the serial ports of your 
computer) can be set up for use with Adlib. If you have connected 
only one device, to COM port 1, then only fill in the COM1 tab. 

2. In the Peripheral type drop-down list, select the specific type of 
the device which you have connected, or try the Generic scanner if 
your scanner is not listed.  

3. In Borrower ID regular expression you may provide a regular ex-
pression to which borrower numbers must comply. This is because 
with the scanner you can scan borrower numbers from library 
cards as well as copy numbers from e.g. books. But the scanner 
doesn’t differentiate between such numbers. So with the regular 

expression you specify the format of the borrower number; all 
borrower numbers which do not comply to this format, will be 
considered copy numbers by Adlib. (See the Designer Help for 
more information about regular expressions.) 

4. Click the Port settings button to set up the port for the specific 
device you connect to it. The documentation of the relevant device 
should provide information about the settings to make here (port 
settings must be set to the requirements of the device). 

This functionality is expressed best in Adlib Circulation, when issuing, 
returning of reserving materials in a library. On the opened tab (Is-
sues, Returns or Reservations) a scanned number will be entered au-

tomatically into the Borrower number or Copy number entry field. 
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